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Conventions

The typographic conventions used in this help are described below.

Convention Description

Bold Used to denote components of the user interface such as

buttons, field names, menus, and menu options.
For example, the New button.

Menu...MenuOption Select the menu from the menu bar then select the menu option
from the menu.
For example, File...Open would mean to select the File menu
and then the Open option.

CAPS Used to denote the name of a key on the keyboard.

For example, the ENTER key.

Italics Used to denote emphasis, captions and the result of an action in
a procedure.

Contact Us
General enquiries on the GPA for DigitalMicrograph should be sent to:

HREM Research Inc.
14-48 Matsukazedai
Higashimatsuyama
Saitama 355-0055

Japan
email: support@hremresearch.com
Website: http://www.hremresearch.com /

Enquiries on GPA of a technical nature should be directed to:

Dr. Martin Hytch
CEMES-CNRS, Toulouse, France

email: hytch@cemes.fr
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Introduction to GPA

Welcome to GPA Phase the DigitalMicrograph plug-in for strain mapping from high-
resolution electron microscope images, or indeed any type of lattice image. The main
reference for the theory is:

M. J. Hytch, E. Snoeck and R. Kilaas, Ultramicroscopy 74 (1998) 131-146.
Quantitative measurement of displacement and strain fields from HREM micrographs

and additionally:

F. Hiie, C.L. Johnson, S. Lartigue-Korinek, G. Wang, P.R. Buseck, M.J. Hjtch,
J. Electron Microscopy 54 (2005) 181-190. Calibration of projector lens distortions.
doi:10.1093/imicro/dfi042.

M. J. Hjtch and T. Plamann, Ultramicroscopy 87 (2001) 199-212. Imaging conditions
for reliable measurement of displacement and strain from high-resolution electron
microscope images.

Applications of GPA can be found in the following:

[1]

[2]

F. Hiie, M.J. Hytch, H. Bender, F. Houdellier, and A. Claverie, Phys. Rev. Lett. 100
(2008) 156602. Direct mapping of strain in a strained-silicon transistor by high-
resolution electron microscopy. doi:10.1103/PhysRevLett.100.156602.

C.L. Johnson, E. Snoeck, M. Ezcurdia, B. Rodriguez-Gonzalez, 1. Pastoriza-Santos,
L.M. Liz-Marzén, and M.J. Hjtch, Nature Materials 7 (2008) 120-124. Effects of elastic
anisotropy on strain distributions in decahedral gold nanoparticles.
doi:10.1038/nmat2083.

M.J. Hytch, J.-L. Putaux, J. Thibault, Phil. Mag. 86 (2006) 4641-4656. Stress and
strain around grain-boundary dislocations measured by high-resolution electron
microscopy. doi:10.1080/14786430600743876.

J.L. Taraci, M.J. Hytch, T. Clement, P. Peralta, M.R. McCartney, J. Drucker and
S.T. Picraux, Nanotechnology 16 (2005) 2365-2371. Strain mapping in nanowires.
doi:10.1088/0957-44/16/10/062.

M. J. Hytch, J-L. Putaux, J-M. Pénisson, Nature 423 (2003) 270-273. Measurement of
the displacement field around dislocations to 0.034 by electron microscopy.
doi:10.1038/nature01638.

Software requirements

The following is a list of the software requirements necessary to run the GPA plug-in:

DigitalMicrograph (GATAN™)

USB Key Driver

HREM Mouse Tool Plug-in (Free-ware downloadable from www.hremresearch.com)
IPU Plug-in (Free-ware downloadable from www.hremresearch.com)
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Software Installation

Installing USB Key Driver
The user key driver should be installed by following the instructions given by the key driver installer.
The key driver installer comes with GPA, or you can find it on our web site.

Installing GPA Plug-in
The plug-in can be installed by drag-and-drop copy to the folder “Pluglns” (The Pluglns folder should
exist under a normal installation of the DigitalMicrograph.)

When the DigitalMicrograph is launched after placing the plug-ins into the Pluglns folder, GPA menu
commands will appear under “GPA Phase” menu.

Installing Mouse Tools
All the files relating Mouse tool plug-in can be installed by drag-and-drop copy to the folder
“Pluglns.” (The Pluglns folder should exist under a normal installation of the DigitalMicrograph.)

When the DigitalMicrograph is launched after placing the plug-ins into the Pluglns folder, the Mouse
tool will appear as an addition to the standard tools.

Installing IPU Plug-in

GPA uses some functions based on the Inte]”’ MKL (Math Kernel Library) provided by the IPU plug-in.
All the files relating the IPU plug-in can be installed by drag-and-drop copy. Please consult the
ReadMe file that comes with the IPU plug-in.

In this manual, we will dive straight into the use of the GPA Phase package with some
worked examples. There is also a quick reference guide at the end of this document.

But before starting, there are a few important points to remember:

1. GPA Phase is a plug-in for DigitalMicrograph (Gatan). This means that results are
fully compatible with the other functions present in DM. For example, the phase
images produced, or strain maps, can be analysed or manipulated with functions like
Analysis...Statistics or Process...Simple Math. However, if new images are
produced by these operations, internal GPA variables will not be transferred.

2. All the commands related to GPA Phase are located in the menu GPA Phase:

Power Spectrum
Phase calculation...
Define Reference  »
Fringe deformation

Strain field..

Repeat Project »
Phase Maths »
Phase Tools »

Add Color Marker

Imaee Group »
Project 4
Reference Imaege »

Help »
About GPA
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3. The only other additional feature to DigitalMicrograph is located in the Standard
Tools Window:

NBEI e S £ T

This mouse tool is a regular feature of other HREM Research plug-ins and is used in GPA
Phase only for the selection of spots in the Power Spectrum, as we will see.

New features of version 4

GPA Phase 4.0 has the possibility of calculating strain maps from multiple, i.e. more than two,
phase images:

*  Multi-phase strain maps. In principle, strain maps can be calculated from just two
phase images. For previous versions of GPA, we typically chose the phase images
from the two strongest spots in the Power Spectrum. But if many viable spots are
available (notably for aberration-corrected HRTEM images) it is a pity to miss the
extra information. A routine has therefore been implemented in v4, which allows you
to calculate the strain maps from as many phase images as you like. The strain maps
are a result of a least-squares fitting procedure and aims to improve the signal-to-noise
ratio of the measured strain. See the Additional Functions section for details.

This is the first time we have updated the basic Strain field... routine since the original
version of GPA, so we thought it worth a version change!

To know more about the idea behind using multiple phase images see:
A. K. Gutakovskii, A. L. Chuvilin, and S. A. Song, Bulletin of the Russian Academy of
Sciences: Physics 71 (2007) 1426-1432. Application of high-resolution electron
microscopy for visualization and quantitative analysis of strain fields in heterostructures.

New features of version 3

GPA Phase 3.0 can handle the complex image, which will be obtained by using electron
hologram or an exit wave reconstruction procedure.
Additional features include:

* Polynomial fit to Lens distortion correction. Lens distortion is normally changes
slowly, and can be expressed by polynomial function. Thus, a polynomial fitting will
reduce random noise in the lens distortion pattern.

* Rotatable RIO. In some case you may want to use the reference rectangle area that is
not parallel to horizontal or vertical direction. Now, after placing a regular rectangle
ROI to show the size you want, you can rotate the rectangle RIO as well as change the
size.

* Color marker. The intensity scale can be added to images (for example, deformation
maps) in the form of a color bar, including minimum and maximum values.

New features of version 2

GPA Phase 2.0 is faster and more user friendly than GPA Phase 1.0. In addition, there are a
number of new features, such as:

* Calibrated images. If the analysed image has a calibrated scale (in nm, for example),
all phase results will be calibrated accordingly (even when binned, see below). More
importantly, the spatial resolution of the results will be indicated when defining the
mask size in GPA Phase...Calculate Phase.

* Image binning. The resulting phase image can be chosen to have a reduced size (in
pixels) with respect to the original image, using the binning option in GPA

-6-
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Phase...Calculate Phase. Analysing a 2048 by 2048 pixel image at binning 4 will
produce results 512 square. This speeds calculations and liberates space. No
information is lost, as the mask used in Fourier space is always much smaller than the
original picture size.

Automatic distortion correction. Previously, a reference image had to be analysed
manually each time the phase images were to be corrected. Now, this is done
automatically. The reference image just needs to be analysed once and saved using the
new menu GPA Phase...Reference Images. All subsequent phase analyses can then
call up and automatic correction using the Distortion tab in GPA Phase...Calculate
Phase.

Repeat phase project. All the operations carried out during a phase project can be
repeated on a new image with just one click using GPA Phase...Repeat phase
project, including strain fields. This means of course that the reciprocal lattice vectors
need to be roughly the same as before. This command is ideal for analysing a series of
images of a specimen.
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GPA Phase Tutorial

Getting Started

Open the image “GPA Test 0” using the DM command File...Open from the GPA Phase
Manual folder:

Technical note: you can find out how this
image was created by looking at the script “GPA
Test image 0.s” in the Phase Manual folder.
Indeed, you can play with the image by
changing the script, in particular the variable
dPhase which determines the displacement.

Hint: to run a script in DM,
press CTRL-ENTER.

Phase calculation...

Define Reference  » Technical note: in GPA, the image does not
Eringe deformation have to be a power of two in size (e.g. 512 by
Strain field.. 512). However, streaks may appear in the power
Repeat Project » spectrum if greatly different in size from a

Phase Maths 3 power of two.

Phase Tools 4

Add Color Marker

Imaee Group 4

Project 4

Reference Imaege 4

Help »
About GPA

You will see an image similar to this:

Technical note: the power spectrum is the modulus squared
of the Fourier transform of the image. People are often
surprised by the lack of a central spot in the power spectrum
but this is normal for images where the mean intensity is
zero, an important difference with diffraction patterns. The
horizontal streaking of the spots is due to the interfaces in the
image and is not, in this case, an artefact.
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% c
Now choose the mouse tool: R e & A@and click on one of the spots.

Why not zoom in using the DM magnifying glass tool: k A 77

Technical note: do not worry about “hitting” the
spot exactly. GPA will automatically hunt locally
for the maximum intensity in the spot, even though
the red square marks the actual pixel you hit.

Hint: if you wish to delete your mark,
click on the mouse mark again with
the SHIFT key down, or use the DM
arrow tool to select and delete.

For the moment we want only one spot marked, but GPA can deal with multiple selections, as
we will see later. The chosen reciprocal lattice vector will be referred to as g.

We are now ready to calculate our first Phase Image:

Define Reference »
Fringe deformation

Strain field..

Repeat Project 4
Phase Maths 4
Phase Tools 4
Add Color Marker
Imaee Group >
Project 4

Reference Imaege 4

Help >
About GPA

The following dialogue box will appear:



GPA Phase Manual

s Create Phase Images
Project Name: |Project1

Mask l Display | Distortion |

Technical note: the choice of the mask type
(shape) is not that critical though the hard circular

" Hard Circular Mask . . .
mask is to be avoided (only included for

iz completeness). Hard masks in Fourier space
lage v [0.0331  1/pixel Apply introduce rippling effects in real-space, which is
Spatial resolution: [30.2 pixels why smooth masks are preferred. Mask size is the
binring: [1_~] most important parameter.
oK | Cancel |

The first choice “Project Name” gives the title prefix for all subsequent results e.g. phase
images, strain maps etc. Choose a short name preferably. For the mask type, use the default
value of “Cosine Mask™ for the moment. The most important parameter is the mask size
(radius) and can be modified using the menu “Size” from small (radius = g/4), medium (g/3)
to large (g/2). As you do this, the result of your choice will be seen on the Power Spectrum:

Technical note: the radius of the mask shows the
area selected in Fourier space around the spot of
interest. Decreasing the mask radius will produce
smoother results but with less spatial resolution.
The maximum recommended size is g/2
corresponding to the large mask size.

Now say OK and the phase image will appear:

Technical note: GPA uses the temperature colour
scale for displaying image values. If you prefer
grey scales use the DM menu Object...Image
Display...Color. Similarly, if you wish to change
the maximum and minimum display values use
DM menu Object...Image Display...Contrast or
select an area on the histogram. In any case, the
actual values in the image will not be changed,
only its appearance.

This phase image has values in radians from —s to +s. The next step is to define area which
will correspond to the reference lattice. Use the DM ROI tool (region of interest tool) to
select and area:

106
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Technical note: choose an area of undistorted
lattice as your reference area, recognised in the
phase image as an area of uniform contrast or
uniform gradient. For example, do not choose an
area which straddles the interfaces. Having said
that, please experiment.

and choose the next GPA phase command Define Reference.

Power Spectrum
Phase calculation...

Fringe deformation
Strain field...

Repeat Project 4
Phase Maths 4
Phase Tools 4

Hint: if you do not like the reference area,
. . just grab and slide the ROI across the
The result will be the following: image. GPA will automatically update the
reference area. This function can be
deactivated in Define Reference...Setup.

Technical note: if you want to know the actual
values of the reference lattice g=(gy,2y,) then look in
the DM Results Window, and if necessary apply
Define Reference...Setup...Show gx, gy. Values
are in pixels”

The phase image now has a well defined reference lattice and can be interpreted. The uniform
area of phase shows that the lattice is identical to the reference (here in blue). The change in
the relative phase shows that the central band (here in yellow) is displaced with respect to the
reference. You can see this on the original image. This is the basis of the geometric phase
technique: the measurement of displacement of lattice fringes.

By choosing the DM profiling tool, the phase shift can be visualised:

1t
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B

0 100 200 300 400

In the reference area the phase is zero and in the central band takes a value of 2.2 radians.
This value can be verified in the original script used to create the image “GPA Test image 0.
From the theory, this represents a displacement of -2.2/2xw of the lattice spacing. Now choose
the reference area in the central band, and you will see that the displacement is reversed. This
illustrates the overall principle:

Only relative phase shifts are important and all measurements refer to the
particular reference lattice used.

Fringe deformation mapping

Most people are interested in measuring deformation and strain, so let us move quickly on
from the phase images and displacement. Open the image “GPA Test 1”:

Hint: to see the lattice rotation,
view the image at a glancing
angle to the page. And if you like,
try and measure the rotation with
standard tools.

NITnne ,\\
AN 5\\\\\\‘ N
-

A cunning distortion of the fringes is hidden in this image. To measure this distortion the
routine as ever is to produce a phase image with a well defined reference. Here is a typical
result:

12
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Technical note: do not worry about the “phase
jumps” i.e. where the phase suddenly goes from
black to white. This is quite normal and results from
the normalisation of the phase between —x and .
Imagine the phase going round a circle moving
seamlessly from 0 to 7 to —t and back again. No
discontinuity is present in the underlying lattice
images.

The abrupt change in gradient of the phase from one side to the other is witness to the
deformation. Let GPA calculate this deformation from the phase image using Fringe

Deformation:
kil % Q: Fringe rotat... [M[=]E3

The first image shows the change in lattice spacing relative to the reference lattice in
fractional units (i.e. 0.02 means 2% expansion). The paired image shows the rotation of the
lattice fringes with respect to the reference in degrees (in-plane rotation of course) and
positive anticlockwise. By default the minimum and maximum values are (£5% deformation
and +5° rotation). Now the deformation and rotation can be visualised by taking profiles or
measured in ROI boxes using DM Analysis...Statistics...Mean and Std. Dev.

Precision and Spatial Resolution

GPA allows the visualisation of lattice deformation. In the previous example, we can clearly
see that the image is divided neatly into two regions. On the left, lattice fringes with a
particular lattice spacing and orientation, and on the right, lattice fringes expanded and rotated
with respect to this lattice (or vice-versa, if the reference lattice was chosen on the right).

GPA is much more than this, however, it is a tool for measuring deformation. Deformation
can be measured using the profile tools and statistical tools in specified areas, as has been
seen. Each pixel in the image is also a measure of the local deformation and lattice orientation.
The question is how local and how precise?

It is not possible to give a general theoretical answer to this question. An experimental way of

estimating will be given here: the standard deviation of the fluctuations in a uniform part of
the lattice gives the precision, and the length scale of these fluctuations gives the spatial

13
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resolution. The fluctuations are assumed to be due to noise, of course. The standard deviation
is easily measured using the DM command Analysis...Statistics...Mean and Std. Dev.

The spatial resolution depends on the mask size used in the analysis. Did you spot the new
feature of GPA 2.0 when creating the phase image for GPA test 1?

iCreate Fhaselmases Technical note: If the original image was
Project Name: |GPAtest 1 not calibrated, the spatial resolution is
Mask | Display | Distortion | displayed in pixels. If you recalibrate the
Tio original image, you need to recalculate the
" Cosine Mask Power Spectrum.
" Hard Circular Mask

Hint: To calibrate an image using
DM draw a line, of which you know
the length in nm, using the DM ROI
tools. Then use Analysis/Calibrate...
To show the scale bar use Edit/Data
0K | Cancel l Bar...

Apply

In this case, the spatial resolution of the results will be 0.2 nm. We also provide the radius of
the FFT mask, « in pixels”, which gives a spatial resolution of 1/« in pixels. Changing the
mask size will change the spatial resolution (updated automatically).

The precision is a direct function of the noise in the image. Double the amount of noise by
modifying the original script “GPA Test image 1” and see the results. Similarly, the spatial
resolution is a direct function of the Mask size used in the GPA analysis. Repeat the
experiment with a smaller mask. Notice that the precision has increased but the spatial
resolution has decreased. This is an essential feature of local measurements, precision is
inversely related to spatial resolution.

When quoting results from GPA, always quote the precision at a certain
spatial resolution.

Determining strain tensors

In order to measure 2-D strain tensors, two sets of lattice fringes are necessary in the image,
as in the image “GPA Test 2

Technical note: a deformation is
indeed present here, see the script
“GPA Test image 2”.

14
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Two phase images are needed to calculate strain, and to do this two spots in the Power
Spectrum can be selected at once.

Technical note: in principle, it does not matter
which two spots you choose, so long as their g-
vectors are not parallel. In practice, the highest
precision is obtained with low order spots and
ones nearest to right-angles with respect to each
other. Spots absent in the crystal structure are to
be avoided (e.g. present due to double diffraction,
misalignment etc.).

Carry out Phase Calculation and notice that a mask is placed around both spots in the Power
Spectrum. Choose a project name of “Test 2" and the results will look like the following:

= F: Test 2 P1

As previously, a reference lattice needs to be defined. This is done by defining an area with
the DM ROI tool on one of the phase images exactly like the previous examples:

wF: Test 2 P1

Hint: it is not always easy to recognise
a good reference region. Just go ahead
and try, and if necessary change the
selection. Usually the situation becomes
clearer after calculating the strain field.

When the Define Reference command is used, GPA will automatically redefine the reference
area on all of the phase images in the group (here, two phase images):

15
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wF: Test 2 P1

Technical note: it is important for
consistency to have the same area of
crystal acting as a reference. This
feature can be deactivated in Define
Reference...setup.

The strain tensor can now be determined with the command Strain. When asked, select the
above two images “Test 2 P1” and “Test 2 P2” for the calculation (default values are the two
most recent images). In the next dialogue, the angle requested corresponds to the direction of
the x-axis with respect to the horizontal (angles anticlockwise positive):

£ Calculate Strain @
Strain 1 Option |
Angle of x-axis to horizontal: |0.0 Hint: if a ROI line tool is

marked on the original
image, the default value will
be parallel to this line.

Show the following images
[v' Symmetric Strain Matrix

[V Mean Dilatation
[V Rotation Angle

Phase to be used .
% P17 P2 Green areas: new features in

GPA 4.0. See later for details.

Un-check All Phases |

=T |

Choosing the x-axis parallel to the picture horizontal axis (i.e. angle zero) and selecting
symmetric strain matrix, dilatation and rotation, the following image group will be obtained:

BE [B]X] = x: Tes' 2Exx  [E]EIX] INES

Technical note: strains as
fractions (e.g. 0.02 equivalent to
2% strain) and angles in degrees
(anticlockwise positive).
Default colour range is 5%
strain and £5° rotation.

Hint: for definition of
strain tensor, see the
Appendix.

This is the final results of GPA strain analysis: the complete 2-D strain tensor.
Now it is your job to enjoy and interpret the results!

16
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(v 4.0)

images

th multiple phase

10N W1

number of useful reflections in the power spectrum has increased significantly. Take a look at

two phase images with the highest signal-to-noise ratio. However, experimental phase images
the following example from an image called GPA SiGe SACTEM:

In principle, only two phase images are necessary to calculate the 2D strain tensor, and in

previous versions of GPA (up to v3), strain measurements were performed by selecting the
are noisy, so it is maybe interesting to be able to combine the information from more than 2
phase images. Indeed, now that aberration-corrected HRTEM is more widely available, the

Additional functions
Strain field calculat
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grown epitaxially on a Si substrate [F. Houdellier & M.J. Hytch, Microelectronic Engineering

84 (2007) 460—463]. Select the 7 spots circled in the power spectrum with the mouse tool and
in the order indicated above. You should find the following images displayed after defining a

reference area:
—
|

This image was taken on the aberration-corrected SACTEM microscope in Toulouse of SiGe
calculate the amplitude and phase images. Use the large mask size and try and use the spots




Now calculate the strain map:

Strain | Option I

Angle of x-axis to horizontal: |21
Show the following images
[v' Symmetric Strain Matrix
[~ Mean Dilatation
[ Rotation Angle

2 a S CEEm ed |
[~ P3
T P5 [ P6

Y
Check All Phases |

OK | Cancel |

r Calculate Strain ‘

Hint: the default phase images are
the two topmost phase images in
DM. Check and uncheck the boxes
as you like.

GPA Phase Manual

By default, strain will be calculated from two phase images, as shown. The default phase

images will be the topmost two phase images in DM, so tick and untick boxes if necessary to
choose P1 and P2 as shown. Verify that the x-axis is parallel to the interface and calculate the
symmetric strain matrix by clicking on OK:

r

B S: SiGe Bxx

o | @ | 2 || g T:siGe By

|
|

o] o s

The exx component is on average zero, indicating that the interface is coherent between the
SiGe and the Si. The &y, component shows that the lattice parameter in the SiGe is larger than
in the Si substrate. However, the image is rather noisy. Rather than reducing the mask size,
let us see what using multiple phase images can do.

18
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Recalculate the strain but this time, check all phase images as shown:

r Calculate Strain @

Strain | Option |

‘ Angle of x-axis to horizontal: |23.6

i~ Show the following images —
[V Symmetric Strain Matrix

[~ Mean Dilatation
[ Rotation Angle

 Phase to be used 5
v P1[vP2vP3
[v P4 |v P5|v P8

v P

:Un-check All Phases :

Hint: use the Check/Un-check All
Phases button to select/deselect all
the phase images.

0K | Cancel I

All the boxes should now be ticked. You can use “Check All Phases” button at the bottom of
the Phase List. Click on OK to calculate the strain map:

EkV:SiGe_Exx o || @] = || & w:sice fyy |_.:; @ | 3|

The improvement to the €,, component is impressive. What has been done? The information
from all the phase images has been combined in a least-squares fitting routine to obtain the
strain maps. In the default version, defined in the option menu, all the phase images are
treated equally.

As always, care should be taken when interpreting the results and phase images should not be
used blindly. Have a look at an alternative selection of spots:

19
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Hint: remember to unselect spots with
the mouse tool, just hold down SHIFT
and click on the spot to delete.

In this case, unselect the old spots 5, 6
and 7, and select new 5, 6 and 7 spots as
shown.

The spots 5,6 and 7 have been changed to produce the following amplitude and phase images:

oo |[Rolol=]|Ee xR |#cla]x]

B o

= =]

o e

o @]=]

l e p
L.z ).dé .

If we unthinkingly choose all the 7 phase images, the following strain maps would be
obtained:

Bk AH: Project6 Exx o | @] & || & AtProjects Eyy o B[]

e e W
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It can be seen that the strain maps are worse than with just 2 phase images! The reason can be
found in the fifth phase image. The amplitude is almost zero in the SiGe layer for this set of
fringes. Uncheck this phase image from the list and you will find a much better result.

As a general recommendation, look at the amplitude images and choose only phase images
which you would be happy to choose when using only two phase images. Experiment, and try
different spots and numbers of spots for the calculation.

Options

Not all phase images have equal significance. We have therefore included a possibility to
weight the phase images in the fitting procedure, the default being no weighting (none). Here
is the list of those options:

% Calculate Strain
Strain Option |

[v' Normalize by g

Weight M None v g ]

e Hint: choose none if you can
SpotAmplitude after screening the amplitude
idge Funphlide images to check that all the phase
Spot Intensity . bl
Image Intensity images are viable.

oK ‘ Cancel |

There are different choices which you can play with: spot amplitude meaning the amplitude
of the spot used in Fourier space (with the same weight to all the pixels), image amplitude
meaning the corresponding amplitude image (with the weight therefore varying pixel to pixel),
spot intensity meaning the intensity of the spot in Fourier space, and image intensity
meaning the square of the amplitude image.

When the “Normalize by g” is checked, the weight of 1/g will be applied. This will sometimes
give better result, because the phase value is proportional to g (spatial frequency), but the
significances (the intensity) of the spot with high spatial frequency is normally becomes low.

Try using one of these options on the last example. You should find that the problematic fifth
phase image (P5) will no longer affect the results. The resulting strain map will however have
a lower signal-to-noise than the none option of the first set of phase images (or by deselecting
P5 manually). The reason is that the spot intensities decrease rapidly and the fitting is
dominated by the first 3 spots, say. As mentioned in the hint, it is always best to screen the
phase images yourself before calculating the strain and use the none option if possible.
Anyway, have fun and see what you find.
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Geometric distortion correction

All optical systems distort the images they form. CCD cameras and scanners (for digitising
negatives for example) introduce additional distortions. Fortunately, these geometric
distortions are usually fixed for a given system. It is therefore possible to eliminate these
distortions by measuring them (usually only once) and then correcting subsequent images.
The procedure is described in Hiie et al. J. Electron Microscopy 54 (2005) 181. The paper
concerns projector lens distortions but is general for all geometrical distortions. All that is
necessary is an image of a perfect crystal (or any other perfectly regular lattice).

Open the image “GPA Test distortion” which is a simulation of a translation boundary:
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Calculate the two phase images as usual after selecting the spots in the power spectrum:
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The information contained in the image is dominated by the geometrical distortions.
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Distortion correction

In order to correct for distortions, you need to set up a reference image. Open the reference
image “GPA Test reference” image and calculate the Power Spectrum.

..... -

.................

Select two spots and calculate two phase images. In principle, any two non-colinear spots
suffice.

Technical note: it is

not absolutely

necessary to define a

reference area but it is
‘ good practise.

With a phase image selected, use the new menu Reference Image and Save As... A standard
Window's dialog will appear to save a file. By default, a folder is created in My Images folder
but you can place your reference images anywhere. A good place, if you have administrator
rights, is in the DigitalMicrograph folder in a folder called GPA reference images. Give the
file a name, say “GPA Test reference”, and click OK. The program will save the GPA Test
reference image with the necessary information for later use.
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Redo a Phase Calculation... for the GPA Test distortion image. At the menu stage, click on
the Distortion tab. It should look something like this:

i Create Phase Images @

Project Name:

Maskl Display Distortion I

Camera: IRonchi camera USC.dm3 LI
I Apply Correction
Lens: IGPA Test reference image noisy.dm3 LI

IV Apply Correction
I Polynomial fit Order: |3+

™ Exclude border pixels |32 v

™ Show fitings

0K Cancel

Now you can choose the reference image you want using the scroll down menu Camera or
Lens depending on the type of distortion. For example, you could have a list reference images
for different cameras on different microscopes. The GPA Test reference corresponds to
projector lens distortions so after selecting the reference in the Lens menu, tick Apply
Correction and click OK.

The phase images will automatically be corrected and, after using Define Reference, will
have a nicely uniform appearance. Only the phase variation due to the crystal structure will
be present:

You only need to define the reference image once. From now on, it will be available in the
Phase Calculation...Distortion tab. If you wish to delete it, just use Reference
Image...Delete.
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Polynomial fitting

You will not always be so lucky with the reference image. Open the more realistic image GPA
Test reference noisy:

Technical note: this
was created simply by
adding noise to the
previous GPA Test
reference image.

Repeat the procedure for defining a reference image for the distortions, and recalculate the
phase image of GPA Test distortion using the new noisy reference. You will find the
following results for P1 and P2:

The results are much noisier than the previous example, because the noise in the reference
image is effectively added to the image. To alleviate this problem, we have included in GPA
Phase 3.0 the possibility of applying a polynomial fit to the reference image phases before
subtracting them from the experimental phase. Recalculate the GPA Test distortion phases by
ticking the Polynomial fit option:
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is/Create Phase Images @

Project Name: [Projectd Technical note: projector lens
distortions are theoretically a

Mask | Display Distortion ' .
l I polynomial of order 3. It is therefore

Camera: [Renchi camera USC.dm3 El logical to use the same order for the
I~ Apply Carrection fitting. However, higher orders can
Lens: |GPA Test reference image noisy.dm3 LI be used if necessary.

vV Apply Correction
[V Palynomial fit Order: m Hint: it is always worth
excluding some pixels at
the borders of images to
avoid edge effects.

I Show fitings

oK | Cancel |

You should find the following result:

The resulting phase images are much smoother, as no additional noise has been added to the
experimental phases. Indeed it would be a pity to add noise to experiments, which are already
difficult to perform!
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Appendixes

A: Important phase relations
Phase and displacement:

P, (r) = -2mgu(r)
2D displacement and phase:

1 -
u(r) = —zLPgl(r)a1 +P,(r)a,  where g.a, =9,

Phase gradient and reciprocal lattice deviation :
VP, (r) = 27Ag(r)

Strain tensor for small deformations:

_ l Ju, auj . u ou, 1{0u.ou,
glj - + L.€. gxx = =5 gvv = - > €, =T 7x+7)
2( dx; ox ox 7 o9y Y 20y o

Mean dilatation :

A, _1 %4_% ie A =5(.9m_+£w)
720 ox,  ox, ’ o

J
Rotation (in radians and anti-clockwise positive):
1(0u, ou ).
w,; == L_—lie @ 1 u, _ou,
2{ ox, ox; Y20 ox oy

Note: these relations are only valid for small deformations. However, GPA
uses the full relations suitable for large deformations (see Appendix in Hytch,
Snoeck, Kilaas.)
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B: Useful DigitalMicrograph commands
DM ROI tool:

D 3 -:- Q P Hint: to select a square area, hold down SHIFT.
: To select powers of two, hold down SHIFT-ALT.
DM magnifying glass:

: Hl
J k @ AT Hint: to demagnify, press ALT.

C: Rotatable ROI

The edge length will be adjusted by one of the
yellow edges, and the rotation angle will be adjusted
by the yellow cross (+). (You can change the both
edge lengths by dragging the yellow cross when
pushing the SHIFT key.)
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Quick Reference Guide

The GPA Main Menu

Power Spectrum
Phase calculation...
Define Reference  »
Fringe deformation

Strain field...

Repeat Project »
Phase Maths »
Phase Tools »

Add Color Marker

Image Group 4
Project »
Reference Image »

Help »
About GPA

The commands in the GPA menu are described below.

Command Description

Power Spectrum First step in the GPA procedure. Calculates and
displays the Fourier transform of the front most
image. Spots are then selected in the image of the
Fourier transform (called Power Spectrum) using the
mouse tool.

Phase calculation... Second step in the GPA procedure. Calculates phase
images for the spots selected in the Power Spectrum.
Results for each spot are displayed and managed as
part of a project (see options).

Define Reference Menu concerning the reference lattice and third step
(see sub menus) in the GPA procedure.
Fringe deformation Calculates the deformation of lattice fringes from the

front most phase image. Displays variation in fringe
spacing (with respect to reference) and orientation (in
degrees, anticlockwise positive).

Strain field... Calculates the two dimensional deformation tensor.
Asks for two phase images and options (see below).

Repeat Project Allows phase images and other output to be

(see sub menus) generated directly from the front most HREM image,

exactly as for a previous project. Also allows to save
details of the current project for later use (even in
other sessions of DM).
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Phase Maths
(see sub menus)

Menu of different mathematical operations which can
be performed on phase images.

Phase Tools
(see sub menus)

Menu of useful operations, not necessarily restricted
to phase images.

Add Color Marker

Adds a color bar and the low and high display ranges.
You can move the whole color marker or change its
size. Since the display ranges are text annotations,
you can move and edit them as you like. The color
marker can be placed outside of the image display.
You can rotate and flip using Edit commands. (The
ratio of the color bar is fixed.)

Image Group Menu to close or save groups of images within a
(see sub menus) particular project.
Project Menu to manage all the images in a particular project.

(see sub menus)

Reference Images
(see sub menus)

Menu to define reference images for distortion
correction due to CCD cameras or projector lenses.

Phase Calculation Menu

Create Phase Image Dialog

The components of the dialog are described below.

Component Description

Project Name Name given to the group of images and results

Mask Tab For information about the components of the Mask
tab, see Mask Tab below.

Display Tab For information about the components of the Display

tab, see Display Tab below.

Distortion Tab

For information about the components of the
Distortion tab, see Distortion Tab below.

OK Closes the dialog and starts the image calculation
according to the specified parameters.
Cancel Closes the dialog without executing the command.
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Mask Tab 7 Create Phase Imaees @

Size

~| |oos2 1/pixel  Apply
Spatial resolution: |0615 nm

Project Name: IGPA test 1

Mask ]Display] Distortion |

Type
(¢ Cosine Mask

(" Hard Circular Mask

binning: |1 v
oK I Cancel |
Component Description
Type Defines the shape of mask used to isolate the

selected spots in the Fourier transform.

Cosine Mask

Half-cosine-shaped mask. Size corresponds to radius
of hard cut-off and cosine quarter period (i.e. first
Zero).

Hard Circular Mask

Top-hat function. Size corresponds to radius of hard
cut-off.

Size Defines mask radius of hard cut-off (beyond which
values are set to zero).
Selection Default values of large (g/2), medium (g/3) and small
(g/4). Custom allows any value.
Text Field In units of pixels in the FFT.

Apply Button

Displays mask size as circles on Power Spectrum
around selected spots (this is just for display
purposes and is not necessary for the calculation).

Spatial Resolution

Displays the equivalent averaging in real space (but
will appear only if the original image is calibrated).

Binning

Defines if the resulting phase images are to be binned
with respect to the original image thus reducing their
size and speeding the calculation.
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Display Tab 7 Create Phase Images @

Project Name: |EZrCEal

Mask Display | Distortion |

Show the following images

v Geometric Phase Image
|7 Amplitude Image

[ Bragg Filtered Image

oK | Cancel |

Component

Description

Show the following images

Choice of images to be calculated and displayed.

Geometric Phase Image

Geometric phase image.

Amplitude Image

Amplitude of lattice fringes.

Bragg Filtered Image

Bragg filtered image i.e. image of selected lattice
fringes.

Distortion Tab 75 Create Phase Imaees @

Mask I

Camera: IGPA Test reference image.dm3 ;I

Lens: IGF’A Test reference image.dm3 ;I

Project Name: |GPA test i

Display Distortion I

[ Apply Correction

[ Polynomial it Order: |3 - I
[ Exclude border pixels |64 v

[ Show fittings

oK | Cancel |

Option Description

Camera Selection of the reference images used for correcting
camera distortions (these need preparing with the
Reference Image menu).

Lens Selection of the reference images used for correcting
lens distortions (these need preparing with the
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Reference Image menu).

Apply Correction

Activates the use of the camera and/or lens reference
images to correct distortions. If both are activated, the
corrections will be applied successively.

Polynomial fit

Activates the use of polynomial fit to the lens
distortion (not for camera distortion).

Order

Specifies the order of polynomial fit.

Exclude border pixels

Specifies the width of border pixels to be excluded
when estimating polynomial fit parameters. (Most of
the cases the border pixels are affected by
discontinuity at the borders. Thus, it is a good idea to
exclude some border pixels.)

Show fittings

Tick to display the polynomial fit in a new window.

Define Reference Menu Refine

Setup...

Option

Description

Refine

Third step in the GPA procedure. Before running the
command, an area needs to be selected by the DM
rectangular ROI tool. The command defines this
region as the reference lattice and adjusts phase
images accordingly (see options).

Setup...

Opens Setup dialog.

SetuP Tab 1'ﬁ Define Referen...

Setup l

v Use Same Area
v Automatic Update

[v Showex gy
v Rotatable

oK

I Cancel |

Option

Description

Use Same Area

Reference area is automatically applied to all phase
images in the project when using the Refine
command or Automatic Update option.

Automatic Update

Moving the reference area automatically updates the
phase images and reference values.

Show gx,gy Displays the values of the reference lattice gx and gy
in the DM Results window each time the reference
area is updated.

Rotatable Tick to make the rectangular ROl rotatable. The edge
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length will be adjusted by one of the yellow edges,
and the rotation angle will be adjusted by the yellow
cross (+). (You can change the both edge lengths by
dragging the yellow cross when pushing the SHIFT
key.)

Strain Field menu

Calculate Strain Dialog
(Strain Tab)

%Q:._ Calculate Strain

Strain J Option [

Angle of x-axis to horizontal: |23
Show the following images
[v Symmetric Strain Matrix
[ Mean Dilatation
[ Rotation Angle
Phase to be used
VPilvpP2[ P3
[T P4 P5[ P8
[~ P7
Check All Phases ’

oK l Cancel |

Component

Description

Angle of x-axis to horizontal

Defines the orientation of the x-axis used for the
strain calculation. Angle defined in degrees from
the horizontal plane of the image to the x-axis
(anticlockwise positive). The values used for the
previous calculation will be shown.

Note: You can specify the orientation of the x-axis
by placing a Line ROI on the HREM image. In this
case, the angle of the Line ROl appears here
automatically.

Show the following Images

Choice of results to be displayed.

Symmetric Strain Matrix

Images of &x«, &,y and ey, to be displayed.

Mean Dilatation

Image of 9, to be displayed (average of & and

Eyy).

Rotation Angle

Image of wy, to be displayed. Values in degrees
and anticlockwise positive.

Phase to be used

Select the phases to be used from the phase list.
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P1 to Pn Phase list with a check box.
Check/Un-Check All Toggle button to check/un-check all phases.
Phases
Calculate Strain Dialog [ calcuiate strain
(0pt|0n Tab) Strain Option |
[v' Normalize by g
Weight Mode '_’:‘,Sf,e—'
SpotAmpliude |
Image Amplitude
Spot Intensity
Image Intensity
OK | Cancel ‘
Component Description
Normalize by g Applies the weight proportional to 1/g.
Weight Mode Selection from a weight list: None/Spot Amplitude/
Image Amplitude/Spot Intensity/Image Intensity.
Repeat Project menu Repeat Current Project...
Repeat Saved Project...
Save Current Project As...
Clean up Project List...
Option Description

Repeat Current Project

Repeats the same operations as carried out in the
current project on the front most HREM image. Note:
the current references of the phase images in the
repeated project are used to calculate the new phase
images. See dialog box for options.

Repeat Saved Project

Repeats the same operations as carried out in a
saved project on the front most HREM image.

Save Current Project As

Saves the details of the current project for later use.

Clean up Project List

Removes project details.

-35-




GPA Phase Manual

dlalo New Project: |Project?
Output Options
[ FonerSpectrum || 7 s eRisiEd
[v Phase calculation [ Distortion correction
|7 Fringe deformation
[ Strain field
OK Cancel
Option Description
New Project Defines the name of the new project.
Output

Power Spectrum

Tick for the power spectrum to be displayed.

Phase calculation

Tick for the phase image to be displayed (including
amplitude and Bragg filtered images if calculated in
the repeated project).

Fringe deformation

Tick for the fringe deformation to be displayed (if
calculated in the repeated project).

Strain field

Tick for the strain field to be displayed (if calculated in
the repeated project).

Options

Define reference

Tick to Define reference in the same area as for the
repeated project.

Distortion correction

Tick to apply the distortion correction as for the
repeated project.

Phase Maths menu

Add constant phase

Renormalise phase
Add phase images
Subtract phase images
Ihvert phase

Option

Description

Add constant phase

Adds a uniform phase value to the front most image
and renormalizes the phase.

Renormalize phase

Renormalizes the phase between —t and +mx.

Add phase images

Adds two phase images together (requested in a
dialog box) and displays result in a third window (after
phase renormalization). If the phases images are in
the same project, the new phase image will have a
reference equal to the sum of the references of the
two phase images. Otherwise, the new phase image
will have a reference equal to the first phase image
selected.
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Subtracts two phase images (requested in a dialog
box) and displays result in a third window (after phase
renormalization). If the phases images are in the
same project, the new phase image will have a
reference equal to the difference of the references of
the two phase images. Otherwise, the new phase
image will have a reference equal to the first phase
image selected.

Invert phase Calculates the negative of the phase (and inverts the
g-vector).

Phase Tools menu Show gx, gy

Sample by 2
Contours...

Create moires
Import phase images

Option Description

Show gx, gy Displays in the DM Results window the values of the
reference lattice gx and gy in 1/pixels.

Sample by 2 Rebins the front most phase image by two and
multiplies the reference by two (thus preserving the
reference values gx and gy in pixels™ of the newly
sampled image).

Contours Superimposes contours on the front most image (see

options).

Create moirés

Creates a moiré image from the front most phase
image. Asks for the magnification factor n equivalent
to moiré fringes every n lattice fringes.

Import phase images

Imports images into GPA, so that they are recognized
as phase images. Dialog boxes will appear asking for
the values gx and gy in pixels™. If the image has tags
called Phase:gx and Phase:gy, these will be
proposed as default. Images that are imported
together will be placed in a project.
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3/ Contours

(Option Tab)
Option I
Contour spacing: |1li]
Number of contours: |00
Mid contour: (0.0
Contour width: 0.0
oK l Cancel |
Component Description

Contour spacing

Step in image values between each contour.

Number of contours

Total number of contours displayed.

Mid contour

Image value corresponding to mid contour.

Contour width

Contour line width in pixels.

Image Group menu Save
Close
Component Description
Save Saves (with dialog) all images in a project of the
same type as the front most image (e.g.
deformation images).
Close Closes (without saving) all images of the same

type as the front most image.
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Project menu Hide
Show
Save
Close
Component Description
Hide Hides all the images in a project.
Show Shows all the images in a hidden project.
Save Saves all the images in a project (with save dialog
window).
Close Closes all the images in a project without saving.

Reference Image menu Save As...
Delete...

Component Description

Save As Saves the HREM image of the current project as a
reference image for image distortions. Two phase
images need to have been calculated. The
reference image will then appear in the Distortion
tab described in Phase Calculation.

Delete Deletes a selected reference image.
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